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Roll Call Connect Administration Guide 
 
 
This document will outline the steps necessary to install and configure Roll Call Connect. 
 
 

What is Roll Call Connect? 
 
Roll Call Connect is an add on product for Roll Call that allows people to access certain functions 
of Roll Call from their computers or mobile devices via a web browser.  It can be restricted to staff 
members only or open to everyone who has a profile with an email in your Roll Call database.   
 
The functionality for people who aren’t on staff includes: 
• View their family summary (Giving/Attendance) 
• Manage their family profiles 
• Add a family member 
• View giving and print a statement 
• View attendance summary and details 
• View groups involved in and record attendance if a leader 
• Give one-time and recurring gifts on-line 

 
Additional functionality for staff includes: 
• Define widgets in the dashboard to focus on specific items 
• Search for families 
• View family summary (Giving/Attendance) 
• Manage profiles for other families 
• View giving summary and details for other families 
• View attendance summary and details for other families 
• View groups and details for other families 
• View/Add visitation records 
• View/Add confidential comments 
 
Your Roll Call Connect Administrator will be able to configure Connect’s options and permissions 
so each Connect user will only be able to see what they are authorized to see. 
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Roll Call Connect Architecture 
 

Roll Call Connect is run via a browser on any device.  There are no apps to download and install.  
Due to the sensitive nature of the data being transmitted, it is highly recommended to obtain an 
SSL certificate and run Apache web server so that your data can be transmitted securely.  Refer to 
the diagram below for more details. 
 

 

 
 
 

A word about Security 
 
SSL Certificates 
 
We recommend that you use HTTPS calls to Roll Call Connect so that the data is encrypted.  We 
also recommend that you use Apache Web Server in front of Roll Call’s Web Server.  The 
configuration steps below are configured to support TLS v1.0 rather than the obsolete SSL v2 or 
SSL v3 protocols. 
 
You can purchase an SSL Certificate from a number of Vendors or you can contact us and 
purchase your SSL Certificate through us using our Vendor.  The Certificates are industry standard 
256 bit encryption certificates. 
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Roll Call Connect Logins 

 
In order to log into Roll Call Connect you must provide your email address and password.  When a 
new account is set up, we validate that the email address and last name entered match the profile 
we have in Roll Call.  If it does, we send an email to that email address with a link allowing the 
password to be set.  This ensures that the person trying to create the account has access to the 
email address on record. 

 
 

Pre-Installation Steps 
 

Prior to installing Roll Call Connect, there are several pre-installation steps that need to be 
accomplished as outlined below. 

 
Get a fixed IP for your location 
 
You will need to obtain a fixed or static IP for your site from your ISP (Internet Service Provider).  
This will ensure that the traffic being forwarded to your site will not encounter a problem due to a 
changing IP address.  There is usually a monthly cost for this depending on your internet package. 
 
Register a domain for use with Roll Call Connect (optional) 
 
Although this step is optional, we recommend that you obtain a domain for use with Roll Call 
Connect rather than using the IP address from step 1.  Using a domain will allow your users to 
recognize where they are going when they get into Connect (i.e. connect-yourorg.com).  There are 
many sites that can be used to purchase and register domains.  Pick your favorite. 
 
Set the IP address of your domain 
 
Once you have a domain, edit the A Record for the domain to point it to the fixed IP address 
obtained in step 1.  This will allow the DNS lookup tables to forward traffic to your specific IP 
address when the domain is used.  Refer to the documentation from the site where you registered 
the domain for more information. 
 
Get an SSL certificate 
 
For security purposes, we highly recommend that Roll Call Connect be accessed using HTTPS 
rather than HTTP.  To access using HTTPS you will need to purchase an SSL Certificate.  An SSL 
certificate is tied to your IP or domain and Company and is valid for a certain period of time.  
These certificates have an expiration date and will need to be periodically renewed in order to 
remain valid.  There are many companies that sell SSL Certificates.  If you’d like, you can obtain 
the necessary SSL Certificate from By The Book – just contact us for pricing. If By The Book 
hosts your Roll Call Server, we can provide you with SSL access for Roll Call Connect for an 
additional monthly cost.  Several files will be generated during this process.  It is extremely 
important that you maintain backups of these files.  Later in this document we will discuss 
what you do with these certificate files. 
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Configure the machine(s) for Apache Web Server and Roll Call Server 
 
Although you can access Roll Call Connect via Roll Call’s built in web server, we recommend that 
you also install Apache’s web server.  You will need to install Apache Web server on a machine 
and you will need to install Roll Call Server on a machine – either a Mac or a PC.  They can be on 
the same machine or a different machine. 
 
There are several steps you will want to ensure are in place. 
 
• Set the Power Options/Energy Saver so that the machine will never go to sleep.  It is Ok for 

the display to go to sleep. 
• We recommend that you have 8GB of RAM on the machine or higher.  The minimum is 

4GB. 
• If you are running a firewall on the machine, make sure to open an exception for the port that 

your Roll Call Connect traffic will be using (default is 443).  If Roll Call Server is running on 
a different machine than Apache, also open up the port that Roll Call’s web server will use 
(default is 80). 

• Write down the current IP address of the machine. 
 
Make modifications to your Router to support Roll Call Connect 
 
By default, HTTPS (SSL) traffic uses port 443.  You will need to log into your Router and open up 
the firewall for TCP/IP port 443.  You will be setting this in the port forwarding section of your 
Router’s settings.  Forward the traffic coming in on this port to the IP address of the machine 
running your Apache Web Server (or Roll Call Server if not running Apache).  If you are already 
using port 443 for something else, you can change this port to whatever you want to and 
forward traffic on that port.  If you want to use a port other than 443, that port will need to 
be specified in the URL for Roll Call Connect (i.e. https://connect-yourorg.com:<port>/co). 
 
You will also want to reserve the IP address of the machine running the Apache Web Server and 
the machine running Roll Call Server - if they are different.  The best way to do this is through the 
Router.  Look in the documentation for the Router to see if you can define DHCP Reservations.  If 
you cannot do this via the Router, you will need to manually fix the IP on the machine(s) running 
your Web Server and Roll Call Server. 
 
Install and start Apache Web Server 

 
We recommend installing Apache Web Server to handle the incoming traffic.  Apache’s web 
server is widely known and trusted.  It handles security and volume very well.  Please refer to the 
section below entitled Install and start Apache Web Server for details. 

 
Test default Apache Web Server 

 
Once you have the default installation for Apache installed and started, you can open a browser 
and type in your URL for Roll Call Connect without the https.  If the initial configuration is 
working properly and traffic is being forwarded correctly, you should get a response back “It 
Worked!” on your web browser.  If not, you will need to resolve any problems. 
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If you have successfully followed these steps, you have finished the pre-installation steps.  The 
next section will outline the steps for installing and configuring Apache Web Server and Roll Call 
Connect. 
 
 

Install and start Apache Web Server 
 

The Apache web server will be used to process incoming web traffic for Roll Call Connect and 
forward that traffic to Roll Call’s integrated web server.  Below are the directions for installing the 
default setup for Apache web server.  A later section will walk you through modifying the initial 
setup for use with Roll Call Connect. 
 
Mac OSX 
 
If you are using a Mac – good news!  It comes pre-installed with Apache.  All you need to do is 
turn it on.  To turn on the default installation of Apache, open a Terminal window and type:  sudo 
apachectl start 
 
That’s it!  Open a browser on the computer and type localhost.  You should see the response of It 
Works!   
 
To stop Apache type:  sudo apachectl stop 
 
Automatically Starting Apache on MacOS 
 
To automatically start Apache on a MacOS environment go to the terminal and type the 
following: 
 
sudo launchctl load -w /System/Library/LaunchDaemons/org.apache.httpd.plist 

 
 
Windows OS 
 
You can find and install Apache from your own source or you can follow the steps below.  At the 
time of writing this document, the current version of Apache was 2.4.12. 

 
• Open up Browser and go to http://www.apachelounge.com/download/. 
• Verify that you have Microsoft Visual C++ Redistributable for Visual Studio 2012 installed 

on your computer.  If not then click the link to install. 
• Download Apache Win32 or Win64 depending on your OS. 
• Unzip download and open the included Readme.  Follow the directions to install Apache and 

ApacheMonitor.  Directions are also included on how to start Apache.  Make sure in the DOS 
window to change directory to C:\Apache24\bin.  Make sure to add Apache as a service and 
start Apache. 

• Set up Apache to run as a Windows Service.  This will automatically start Apache when the 
machine starts and stop it when the machine is shut down. From a DOS prompt go to the 
Apache24/bin folder. 

 
To add Apache Service - httpd.exe –k install 
To remove Apache Service - httpd.exe –k uninstall 
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Open a browser on the computer and type localhost.  You should see the response It Works!   
 
You can use the Apache Service Monitor to start, stop and restart Apache.  Once started, it resides 
in the system tray. 

 
 

Install Roll Call Connect 
 
Roll Call Connect runs in a browser on your computer or mobile device so there is no software to 
install on these devices.  However, since Roll Call Connect accesses your Roll Call data, you will 
need to install Roll Call Server software on a computer (either Mac or Windows OS).  By The 
Book also offers a monthly service where we install and manage your Roll Call Server on one of 
our servers.  If you are interested in this option please contact our office. 
 
To install Roll Call Connect you will need to perform the following steps: 
 
Install Roll Call Server 

 
You can either run Roll Call Server locally or have By The Book host your Roll Call Server.  If 
you run it locally, you will need to pick a computer (either Mac or Windows OS) on which to 
install Roll Call Server.  If you already have Roll Call Server installed then you can skip to the 
next step.  If you are currently running Roll Call Standalone, you will want to uninstall it, install 
Roll Call Server and move your data file from standalone to server.  Click on the following link to 
get the installer for Roll Call Server: http://www.bythebook.com/support/downloads/.   
 
Refer to the Roll Call User manual for instructions on installing Roll Call Server 
https://s3.amazonaws.com/btb-downloads/v13/manual.pdf. 
 
We recommend a computer with 8 GB of RAM (minimum of 4GB) for Roll Call Server when 
running Roll Call Connect. 

 
Install Roll Call Client 

 
In order to enable Roll Call Connect you must log into Roll Call Client.  If you already have Roll 
Call Client installed on a computer you can skip to the next step.  To access the installer for Roll 
Call Client please refer to the link above.  You may install Roll Call Client on the same computer 
as Roll Call Server or on a different computer. 

 
Enable Roll Call Connect 

 
Start Roll Call Client and log in as Director or Administrator.  Click on the File > Enter License 
menu.  Click on the Connect tab and either enter your license# for Connect or click on the “Try it” 
button to get a 30 day trial. 
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You will need to shutdown Roll Call Client and restart Roll Call Server.  On Mac  OS X, when 
you restart Roll Call Server it may ask you to install a 4D Helper tool.  Make sure you do this. 
 
A word about the 4D Helper tool (Excerpt taken from 4D’s Language Reference Manual) 

 
HelperTool under Mac OS X   
Under Mac OS X, using TCP/IP ports reserved for Web publishing (ports 0 to 1023) requires 
specific access privileges. In order for you to be able to use these ports, 4D provides a utility 
program named HelperTool. When this program is installed, it retrieves the appropriate access 
rights and automatically takes charge of opening the Web ports.  
The HelperTool application is included in the 4D software. Installation takes place automatically 
during the first opening of a port <1024 on the machine. The user is informed that a tool is going 
to be installed and is prompted to enter a name and an administrator password for the machine. 
This operation only takes place once.  The application is renamed "com.4D.HelperTool" and is 
installed in the folder "/Library/PrivilegedHelperTools/." After the initial sequence, the 4D Web 
server can be started and stopped transparently, regardless of the 4D version used. 
 
 
Verify the Roll Call’s web server is working 

 
On a computer connected to the same network as the Roll Call Server computer, open a browser 
and type: http://<ipaddress>/co where <ipaddress> is the IP address of the computer running Roll 
Call Server.  The login window for Roll Call Connect should appear. 
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At this point you have Roll Call Connect working internally on your network using the default 
settings.  To access Connect outside of your internal network or to change the port that Roll Call’s 
web server runs on refer to the next section. 
 
 

Configure Roll Call’s Web Server for use with Connect 
 
Roll Call Connect will be accessed from a variety of devices that will need to connect to your Roll 
Call database from outside of your internal network.  To accomplish this, you will need to make 
your Roll Call database Web Server accessible to outside devices. 
 
This section outlines how to configure Roll Call’s web server as well as other steps necessary to 
accomplish this task. 
 
• Web Port: The default web port for Roll Call’s web server is 80.  In some environments, port 

80 is used for another web server.  If you are running Apache then you must change this port 
to something other than 80 (i.e. 8080).  Roll Call’s web port can be changed, however, if 
you change this port you will have to change it again after each upgrade or patch to Roll 
Call Server.  From within Roll Call Server on Mac click File > Database Settings and select 
Web Tab.  From within Roll Call Server on Windows click Edit > Database Settings and 
select the Web Tab.  Change the TCP port to whatever you want it to be and click OK.  Do 
not click the box to Launch Web Server at Startup. 
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• Firewall:  Since you will be allowing outside traffic into an internal computer, make sure to 

turn on the Firewall on the computer running Roll Call Server. This may be the OS firewall 
of the Anti Virus firewall.  Make sure to allow traffic through on the Web Port you chose 
above.  You will also need to allow Roll Call Client traffic to be allowed.  Roll Call Client 
uses ports 19812-19814 by default. 

 
• Static IP for Roll Call Server computer:  As mentioned in the Pre-Installation section, you 

want the computer running Roll Call Server to always get the same IP address from the 
router, so  make sure to set a static IP for that computer.  The best way to accomplish this is 
through the router using DHCP reservation.  Refer to your router documentation to set this.  
If it can’t be set through your router directly, fix the IP address under the Network Settings on 
the computer. 

 
With these basic configuration changes, you should be able to open a browser on any device and 
type in the IP address or domain and see the Roll Call Connect Login screen.  If you are running 
Roll Call’s web server on another port other than the default of 80, you will need to type: 
http://<ipaddress>:<webport>/co 
 
Where:  
• <ipaddress> is the external IP address or domain for Roll Call Connect 
• <webport> is the port number where Roll Call’s web server is running on (if it is port 80 then 

you do not need to specify this) 
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Not using Apache 
 
If you decide that you don’t want to use Apache’s Web Server, you will have to copy your SSL 
files into your Roll Call Server environment.  Two files make up the certificate that is required: 
cert.pem and key.pem.  It is important to have backups of these files.  These two files must be 
added to the Roll Call Server installation as outlined below. 
 
• Mac OS X:  Open the Roll Call Server application package.  Copy these two files in the 

Server Database folder.  After any upgrade or patch to Roll Call Server, make sure these 
files are still in place. 

 

 
 
 

• Windows:  On windows, go to the C:\ByTheBook\ROLLCALL_Server\Server Database 
folder and copy these two files into this folder. 

 
If you are using an SSL certificate and are going straight into Roll Call’s web server rather than 
through Apache, you will need to turn on “Enable SSL” and change the port if other than 443. You 
may change this port if you wish however, if you change this port you will have to change it 
again after each upgrade or patch to Roll Call Server.   
 
 

Configure Apache Web Server for use with Roll Call Connect 
 
If you are going to use Apache web server, there are some necessary steps to configure the basic 
Apache configuration to run Roll Call Connect successfully.   
 
Copy SSL Certificates 
 
In order to use SSL, you must copy the SSL Certificate files previously generated to a location on 
the machine.  Create a directory in the location of your choice and copy the two crt files and the 
key.pem file to this location.  You will need to specify this location when you configure Apache. 
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Modify the Apache Configuration 
 
You will need to modify the httpd.conf file that is included with Apache.  It is located as follows: 
 
• Mac OS X = /private/etc/apache2/httpd.conf  
• Windows = C:\Program Files\Apache\conf\httpd.conf 

 
Open a browser and type https://s3.amazonaws.com/btb-downloads/Misc/ApacheConfig.txt and 
copy the text to the bottom of the httpd.conf file using an editor.  The configuration file will allow 
traffic directly using https as well as redirect traffic from http to https.  Make sure to change the 
parts in <> with your specific entries.  This assumes using port 443.  If you use another port 
change 443 to whatever you choose.  Restart your Apache web server. 
 
The following lines illustrate the lines in the file you can copy using the link above. 
 
Listen 80 
Listen 443 
 
On Mac the next 4 lines should be removed since they are already being loaded earlier in the 
file. 
LoadModule headers_module modules/mod_headers.so 
LoadModule proxy_module modules/mod_proxy.so 
LoadModule proxy_http_module modules/mod_proxy_http.so 
LoadModule ssl_module modules/mod_ssl.so 
ServerName <SSL domain name> 
 
<VirtualHost *:80> 
 ServerName <SSL domain name> 
 Redirect permanent / <SSL domain name>/ 

</VirtualHost> 
 
<VirtualHost *:443> 
 ServerName <SSL domain name> 
 SSLCipherSuite 

"ALL:!aNULL:!ADH:!eNULL:!LOW:!EXP:RC4+RSA:+HIGH:+MEDIUM:-DH+3DES:-
RSA+3DES" 
  SSLProtocol ALL -SSLv2 -SSLv3 
  SSLEngine on 
  SSLCertificateFile <crtfiledestination> 
  SSLCertificateKeyFile <keyfiledestination> 
  SSLCACertificateFile <CAcrtfiledestination> 
  <IfModule mod_proxy.c> 
   ProxyRequests Off 
   <Location /> 
    ProxyPass http://<internalIPaddress>:<webport>/ 
    ProxyPassReverse http://<internalIPaddress>:<webport>/ 
    RequestHeader set X-Forwarded-Proto "https" 
   </Location> 
  </IfModule> 
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</VirtualHost> 
 

Where:  
• <SSL domain name> is the domain used to obtain the SSL certificate. 
• <crtfiledestination> is the file directory and name of the crt file. 

o Windows – ex: “C:/Apache24/ApacheCerts/…” 
o Mac – ex: /etc/ssl/crt/… 

• <keyfiledestination> is the file directory and name of the key file.  See example above for 
formatting. 

• <CAcrtfiledestination> is the file directory and name of the CA crt file.  See example 
above for formatting. 

• <internalIPaddress> is the internal IP address of the machine running Roll Call Web 
Server. 

• <webport> is the port number where Roll Call’s web server is running on (if it is port 80 
then you do not need to specify this). 

 
Save the configuration file and restart Apache.  You should now be able to test your domain using 
SSL.  Open a browser and type https://<yourSSLdomain>:<webport>/co and see the login page for 
Roll Call connect. If using port 443 then you don’t need to specify <webport>. 
 
 

Configure Roll Call Server to automatically start 
 

It is a good idea to have Roll Call Server automatically start up when a machine is turned on.  Here 
is how you do it: 

 
• Mac OS:  To automatically start Roll Call Server on a Mac, the easiest way is to add Roll Call 

Server into the Log In Items for the Administrative User on the machine.  If you do this, 
however, remember that Roll Call Server won’t be started until that user has been logged on 
and it will shut down if that user is logged out.  You can also configure the machine so it 
automatically logs into your Administrator user on startup.  If you do this be sure to set the 
display to go to sleep and require a password to bring the display back. 

 
• Windows OS:  Windows makes this easy.  Open up Roll Call Server.  You might need to 

right click on the Roll Call Server icon on your desktop and select to run as Administrator.  
Once Roll Call Server is started, click on the File Menu and choose Register current database 
as service.  Shutdown Roll Call Server and open the windows Services.  At the top of the list 
should be 4D Server: ROLLCALL.  Double click and select to automatically start.  Apply the 
change and start the service.  Roll Call Server will now run as a service in the background.  
You will no longer see it running on the task bar.  You can now log out of the OS user and 
Roll Call Server will continue to run. 

 
 

Accessing Roll Call Connect 
 
There are two portals to Roll Call Connect that can be accessed via a web browser: 
 
Connect Portal 

 
To access Roll Call Connect type: 
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https://<ssldomainname>:<webport>/co 
 
Where:  

• <ssldomainname> is the domain name for your SSL Certificate 
• <webport> is the port number on which Apache is listening for SSL traffic (if 443 then 

you don’t need to specify this. 
• You may only use HTTPS if you have purchased and installed an SSL certificate 

 
 

Giving Portal 
 

If you have enabled On-Line Giving in Roll Call Connect, you can access the giving portal from 
within Roll Call Connect.  However, you might want to send an email with a direct link to the 
giving portal or add a link to your website to enable direct access to the giving portal.   
 
The link is:  
https://<ssldomainname>:<webport>/co/give 
 
Where:  

• <ssldomainname> is the domain name for your SSL Certificate 
• <webport> is the port number on which Apache is listening for SSL traffic (if 443 then 

you don’t need to specify this. 
• You may only use HTTPS if you have purchased and installed an SSL certificate 

 
 

Configuring Roll Call Connect 
 

Please refer to the Roll Call Connect User manual on how to configure Roll Call Connect.  You 
can configure the appearance, settings, permissions and online giving. 
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Roll Call Connect Checklist 
 
 

 Get a fixed IP from your ISP 
 

 Register a domain for use with Roll Call Connect 
 

 Set the IP address of your domain 
 

 Get an SSL Certificate for your domain 
 

 Configure the machine(s) for Apache Web Server and Roll Call Server  
  

 Make modifications to your Router to support Roll Call Connect 
 

 Install and start Apache Web Server 
 

 Test default Apache Web Server 
 

 Install and start Roll Call Connect 
 

 Configuring Roll Call’s Web Server for use with Connect 
 

 Configure Apache Web Server for use with Roll Call Connect 
 

 Restart Apache Web Server 
 

 Configure Apache Web Server to automatically start 
 

 Configure Roll Call Server to automatically start 
 

 Test Roll Call Connect access 
 

 Configure Roll Call Connect (Settings, Permissions, Online Giving, etc.) 
 


